
The fighT for 
google rankings



Page 1

PrePare for 

Seo Battle!

This book is a greaT 
sTarTing poinT on 

your quesT To become 
an seo ninja



Page 1

aint got time 

for book intros

action heroes have no time 
to read introductions.

There’s one at the back of the book if you get time off from beating 
up bad guys though.

although i appreciate you ain’t got time to bleed, or indeed for book 
intro’s. if you are viewing this book online, Then please zoom out a 
bit using the view menu on your browser or the pop up menu which 
should appear if you hover your mouse near the bottom of the 
screen. 

you can also press cTrL and the minus key 

Thanks!



Page 1

contents

page 5 - seo basics
page 7 - hTmL basics
page 9 - meta Data
page 10 - on page optimisation
page 11 -  rich snippets
page 13 - meta robots
page 14 - off page optimisation
page 15 - The perfect Link
page 16 - seo campaigns
page 17 - page metrics
page 17 - Web browser plug-ins
page 18 - competitor analysis
page 19 - advanced search queries
page 20 - social media marketing
page 22 - Wordpress basics
page 24 - excel basics
page 29 - hTmL 5
page 34 - introduction
page 35 - references



Page 1

okay so here is the stuff you need to know bro -

seo basics

search engine
google.com or bing.com, or a similar website. one that returns a list of relevant websites when you enter a
word and search for it.

seo
stands for “search engine optimisation / optimization” (depending on uk or us).

it is the art/science of getting to, and maintaining websites at the top of google search engine results 
pages for different keywords. getting to the top of google, will mean that your website should get more 
traffic, meaning that your website can make more money, or make you famous, or whatever it is your 
website ‘s purpose in life is.

googLe aLgoriThm
This is the formula that google uses to calculate which websites should be ranked, and at what position 
on it’s own results pages. This evolves constantly to try and make the results more accurate and more 
relevant.

keyWorD
The word or phrase that is typed into google.com (or bing.com) and searched for. For example, if Dave
wants to buy tennis balls, he’ll probably use the keyword “Tennis balls” to find a suitable online shop. most
seo professionals will refer to a phrase or a single search word, as a keyword. so “tennis balls” will be 
refered to as a keyword, despite it being two words. if you want to rank number 1 on google.com for the 
keyword “Tennis balls” then that phrase should be contained within the text of your website, the headers on 
the site, the ‘meta-data’ and the image alt descriptions.

keyWorD research
This is an important part of seo and may form the start of an seo campaign. it is the process of identifying
keywords to target a particular web page at. For example a tennis website may want to rank high for “Tennis
balls’ but there may be too much competition for this keyword. The webmaster uses the google keyword
Tool and http://ubersuggest.org/ to identify more, less competitive keywords to target. keywords with 
large amounts of search volume are often referred to as head Terms, whilst keywords, with less search 
volume, that are usually more specific are called Long Tail Terms or Long Tail keywords. a long tail keyword 
for tennis balls may be - “slazanger bright yellow tennis ball used at Wimbledon”. These long tail keywords 
should not be ignored, as someone looking for a more specific item or a more specific result, is more likely 
to buy or interact with a website. he/she is most likely in the final stage of the buying process. someone 
browsing for just general “tennis balls” however, may still be researching which make of ball he or she wants.

Links
Links! seo is alot about generating links! This is part of “off-page optimisation”. Links are clickable text or
images, that take an internet user to another webpage.
in seo you want a lot of links, from similar websites/websites from the same niche, going to your website.
Links are a big part of the google algorithm. Links from relevant  & related websites are best.
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get links from 

related sites
Link anchor TexT
if someone links to your website, they will, most of the time, link via text. Whatever the clickable text is,
represents the links anchor text. so if your friend has a website and on his hompage it says:
click here to visit my friend’s website.
The anchor text would be “click here”
generally speaking if you have 100 different links going to or “pointing” to your website’s homepage,
you would want a range of different anchor text, some containing your brand or website name, and some
containing important keywords.
if all 100 links had exactly the same anchor text, google may judge this as being “unnatural”, meaning
that it appears to have been artificially manipulated somehow (e.g. by paying people to link to you or using
some kind of spam engine). google would then penalise you for this, by giving you a lower ranking.
a link is produced with hTmL code. This is described later in the book, but to produce a link, the following
could code be used:
<a href=” http://seoandmma.wordpress.com/”>anchor Text - click any of this to visit the site</a>

no-FoLLoW Links
The code for no-Follow links is:
<a href=”http://www.example.com/” rel=”nofollow”>Link text</a>
no Follow links do not pass any “seo juice” to the page or site that the link points to.
no follow links, in theory, do not help you to improve your google ranking. They will potentially, still
pass traffic to your website and can even increase the authority of your site, if the link is from a well
known and respected site.

WhiTe haT, grey haT & bLack haT seo
if a company participates in White hat seo, then they are very ‘ethical’, they abide by all the laws and
suggestions made by google and do not try and ‘cheat’ the algorithm. The company is interested in medium
and long term results, and wants to protect its brand image.
White hat seo involves creating great content, that people will want to share and link to because it is so
great!
black hat seo on the other hand, is the process of trying to ‘cheat’ your way to the top of google, using
spammy, unethical tactics. These have included generating thousands of links back to your site using a
spam engine that automatically comments and embeds links on blogs and forums.

grey hat seo is anything that falls in between. paying for links would generally be considered grey hat.

“Links are the basic, most valuable element of seo. Links are like a good mount & side control escape,
guillotine and arm triangle in brazilian jui jitsu. 

you can’t get very far without these basic building blocks”
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sociaL signaLs
another element of off page optimisation is social signals. This relates to how often your webpages, or
content from your own website or your own Facebook page or Twitter or google+ etc. account is 
shared or retweeted or interacted with in some way. some websites will publish pictures for example 
on their Facebook page and encourage fans to “like” the image. other websites will publish content on 
their webpages and include “social share buttons”, so that people can click and share content with their 
Facebook friends, or Twitter followers, for example.
generally speaking, the more Facebook likes, and shares and Twitter retweets a site gets, the higher a 
site will tend to rank on google.

googLeboTs / spiDers
you don’t have to understand how these work. just be aware that they ‘read’ a website, and put websites 
into their ‘index’ (google’s big catalogue of websites), in a relevant section according to what keywords it 
finds on the website and within the website’s code.

serps
stand for “search engine results page”. These are the pages which google displays once your search has 
been completed.

ppc - not part of seo but important to understand!
This stands for “pay per click” advertising. ppc are adverts that are paid for each time they are clicked.
google has the search network adverts which are displayed on the top and the right hand side of serps,
and are shaded light yellow. google also has a display network, with adverts appearing on sites like 
youtube. seo doesn’t influence ppc adverts, instead it influences the organic rankings, which are 
displayed down the centre of a serp.

hTmL
hTmL stands for hyper Text markup Language. it is the code that generates a website. it tells your web
browser - e.g. internet explorer what should be displayed.
hTmL uses tags to explain how things should be displayed. For example <b> and </b> placed around a
word like this:
<b>massiVe</b>
Would display the word massiVe in bold.
you normally need to use a tag at the start and a tag at the end.

important tags for seo include <h1></h1> these create a website header text, and tell google what the 
site is
about. For example if the website header was “bodybuilding” it tells google that the site is about getting
massive.

Seo basics
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seo basics

hTmL conTinueD...
To insert an image into a website, you would have to use the <img> tag. For blind or visually impaired
people who use screen readers, you should also use a text description, an ‘alternative’ to seeing the image.

<img src=”on my desktop/in this folder” alt=”some_text”>

<img src=”file:///macintosh hD/users/Drewgriffiths/Desktop/phonepics/mma.jpg” width=”400”
height=”512” alt=”picture of Drew Fighting” />

The above example, is the code i would use to place this beautiful picture on my website.
The first part, the image source, refers to where on my computer the picture is located. in this case, on
my desktop, in my phonepics folder. Width and height just denote the dimensions of the pic and then
the alt= part of the code, is the alternative text, used to tell partially sighted people what the picture is of.
alt text should contain the keywords that you are trying to rank high on google for. so for if we wanted
to rank high for “Tennis balls”, put a picture of a tennis ball on your site and put “tennis balls’ in your alt
text. and in your header somewhere <h1>Tennis balls</h1>
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hTmL conTinueD...
i learnt hTmL by using adobe Dreamweaver. it is unfortunately quite expensive. you can look to pick up an
old copy on eabay or somewhere or use a free alternative. 
check out http://www.osalt.com/dreamweaver for some similar programs. here i’ve simply chose 
to insert an image using the menu on the right hand side, and chosen the image by locating in on my 
computer and double clicking it. Dreamweaver generates the relevant code (left hand side of the screen). 
When i initially chose to make a new hTmL document Dreamweaver also generated all the ‘base’ code for 
me.

This base code, as i have called it (this is not an official term) that Dreamweaver has generated for me 
includes the <head> </head> tags - which denote the header of the website, which isn’t displayed, but 
contains important code. The point to remember is - don’t worry too much about understand all of the 
code, alot of it is standard on every html document, and is there literally just to tell a browser that it is a 
html document

meTa DaTa
meta Data is a bit like training legs. it’s a massive pain, but has to be done. you’ll never be a bodybuilder
without building those wheels, and you’ll never be any good at seo if you don’t understand meta-data.
meta data is not displayed on the actual web page and is contained within the head of the html. it provides
spiders / googlebots with information about your website and provides a desccription to display on 
serps.
it includes:
<title>This appears on the browser and should be a summary of your site. 10-60 characters</title>

<meta name=”keywords” content=”keywords, here, for, google, to, know, what, you, want, to, rank, 
for”>

<meta name=”description” content=”should be less than 200 characters, should contain keywords & 
summarise your website. This appears on serps”>

<meta name=”author” content=”put your name here if you produced the site”>

seo basics
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seo is divided into on and off page optimisation. on page refers to hTmL and actual content, such as text,
as well as the linking structure of the website.

basics of on-page optimsation include

- meta title, keywords, description and author all completed properly, containing keywords near the

 beginning if relevant.

-  alt text for all images - containing keyword(s)

-  use descriptive names for your images. e.g.

-  a simple text navigation system. all pages should be easily accessible and none should be “orphaned”.

 i.e. none should be impossible to navigate to from the homepage.

-  make sure you have keywords in your head <h1> tags

-  make sure your web address (urL) contains keywords. e.g. 

 http://seoandmma.wordpress.com/meta-data

 rather than http://seoandmma.wordpress.com/123425

 having the page called “meta-data” will help the website appear in the google serps when people  

 search for that term. use hyphens - to seperate words.

-  make sure that all the content on your site is unique to each page. make sure it is not duplicated  

 anywhere else on your site or on another site

-  make sure that your code is valid and don’t use too much Flash on your site as googlebots can not  

 read whatever is contained within it.

-  use keywords in the body/copy of your web page and use variations of it, in total at least 2 to 3 times

-  keep the meta title to 65-75 characters long and have important keywords near the front.

-  include a sitemap and robots.txt for larger websites (see next page for more info)

-  rich snippets - a fairly new type of code to provide additional information to search engines about  

 your website. see the next page for more information.

on page

optimisation
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just as mma fighters evolve so does seo. The new technique for on-page seo involves a type of structured
data that allows people to code their websites in a way that provides more in depth information to
google and other search engines.

rich snippets are meta-data (yes, even more meta-data); that allow additional information such as movie
ratings (see pic above) to appear on serps.
The “semantic Web” is the idea of organising all websites into neat catagories and with a standard way of
describing their content.

This webpage here is the best guide i have found on the web so far - http://schema.org/docs/gs.html
it explains how to mark up the meta data properly for your own website.

you can use rich snippets if your website is about a movie, a book, an organisation or a person. For a full
list of circumstances within which you would use rich snippets please see -
http://schema.org/docs/schemas.html

another useful link, for generating your own rich snippet code is to visit:
http://www.snippetgenerator.com/and enter the relevant information. Then copy and paste the code into
your website header.

i took the following data from http://www.tutorialspoint.com/html5/html5_microdata.htm to help explain
the rich snippets in a bit more detail:
To create an item, the itemscope attribute is used.

To add a property to an item, the itemprop attribute is used on one of the item’s descendants.

here there are two items, each of which has the property “name”:

<div itemscope>
<p>my name is <span itemprop=”name”>Drew</span>.</p>
</div>

rich snippets

i hope you’re enjoying this book if you have any issues or questions email me
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rich snippets, introduces five global attributes which are used to give standard summaries of your content:

itemscope - This is used to create an item. The itemscope attribute tells google there is microdata on  
  this page.

itemtype  -  This attribute is a valid urL which defines the item and provides the context for the 
  properties.

itemid  - This attribute is global identifier for the item.

itemprop  - This attribute defines a property of the item.

itemref  - This attribute gives a list of additional elements to crawl to find the name-value pairs of  
  the item.

use rich snippets on your website to help improve your ranking and click through rate (the percentage of
people that click on a link to your site on a serp).

i wouldn’t worry too much about understanding what all the code means, just use a generator website and
copy and paste the output into the header of your site code.

rich snippets is pretty difficult to grasp at first so don’t worry if this section has left you a little confused.
it’s all part of training to be an seo hero:
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meTa roboTs
http://www.robotstxt.org/meta.html is the ultimate source of information for meta robots and robots.txt
The robots tag is a way of stopping google from indexing pages of your site. say for example you were 
experimenting with a new homepage on www.seoandmma.wordpress.com/newsite but didn’t really want 
your website visitors to see this page, because it is not ready for ‘public release’ yet, then you would use the 
robots tag to prevent it from appearing on google serps.
in the head of the code for the page /newsite place the code:
<meTa name=”roboTs” conTenT=”noinDex, noFoLLoW”>
to prevent it from being indexed by the googlebots.

instead of placing code on specific pages, you can use a website such as http://tools.seobook.com/robots-
txt/generator/ to generator a robots.txt file.

you can read more about the robots.txt file at http://www.robotstxt.org/robotstxt.html

you can allow certain search engines to index and crawl your site, and ‘disallow ‘others

siTe map
if you have a fairly large website, and you are not able to navigate directly to all of your pages from the
homepage, then you can make life easier for googlebots, by creating a sitemap.
Visit http://www.xml-sitemaps.com/ and generate one for your site and upload it to your domain. it should
be accessible via www.yourwebsitename.com/sitemap

sTaTus coDes
ever tried to navigate to a page and seen a 404 not found error?
Well, there are a ruck more you should learn to be an seo pro in order to fix errors on a large website.
you can find the full list here - http://en.wikipedia.org/wiki/List_of_hTTp_status_codes
but let me summarise them for you:
200 The request has succeeded - i.e your page has loaded
300 multiple choices - your requested urL may have several versions that can’t be put into 1 page to       
       return
301 moved permanently - requested page has moved to a new urL
307 Temporary redirect - requested page resides temporarily under a new urL or uri
400 bad request - request not understood
401 unauthorized - requires user authentication
403 Forbidden - request understood but not allowed
404 not Found - no page found matching the urL you typed in or clicked a link to
410 gone - web page no longer available
500 internal server error
501 not implemented - request can’t be completed by the server
503 service unavailable - server may have crashed
550 permission denied
a code starting with a 1 is an informational code, if it starts with a 2 it confirms a successful server 
request,
starting with a 3 indicates a redirect and codes starting with 4 or 5 indicate errors with client or server.

Meta roBotS
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off page optimisation/optimization refers to everything you do to gain links to a webpage or website,
that does not include editing your own site’s content or code. Very generally speaking, off page optimisation
is the art of gaining links from related websites, and creating ‘social signals’ by creating content
that people will want to share with their friends.

basic oFF page sTraTegies incLuDe
- build Links! off-page optimisation’s purpose is normally to produce links back to your website. you
may have to build some great content on your web pages in order to do this. if your on-page content is
great, you would build links off page.

- social shares - a seo campaign may also aim to get content shared on social media platforms
share high quality content (ideally from your own site or blog) via social media platforms such as
Facebook, Twitter, Linkedin, google+ and pinterest.

- guest posting on other blogs. This tactic has died off a bit in recent months (it’s currently December
2012), but can still be a useful tool to build links if not overused. you need to use google or social
media sites like Twitter to find blogs that write about and cover topics related to your website. Then
contact the blogger with a good piece of content. offer to give it to them, to use on their site, in
exchange for a link back to your own website.

- press releases - press releases can get you visit page visibility if they are distributed by the right websites.
place keywords and links back to your website in the press release. a press release should include:
Title - include a keyword, preferably near the start.
summary - summarise in a paragraph what the press release is about
body - Write subjectively, and in the 3rd person. include some quotes and stats if applicable.
about the company - small paragraph about your company
press contact - 1 person from your company who acts as a media contact.

submit your press release to onlineprnews.com, dbusinessnews.com, seenation.com, google.com/base,
pr-usa.net, openpr.com, i-newswire.com and prlog.com

see this slideshare presentation for more information on how to submit press releases and to which
sites:
http://www.slideshare.net/cokelly/seo-copywriting-submitting-seo-press-releases-291383

off PaGe 

oPtIMISatIoN
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The perfect Link! Well, where to start on this one. There are many factors to consider when considering
what the perfect link would be. The main, and arguably most important characteristics of a link would be:

- The link is from a site that has content related to your niche
- The link is from a web page and site that is ranked highly for a keyword that is related to your niche
- The link is from a site and a web page that has impressive authority and page rank (see Web page metrics 
section)
- The link is from near the top of the page
- There are only a small number of other links on the web page linking to your website.
- The anchor text of the link is a keyword or a phrase containing the keyword.
- The link should be surrounded by other text, and be in the body and not in a sidebar for example.
- The link should not be reciprocated from the page it is pointing to.
- The page the link is from has no “sponsored links” and does not mention sponsored links or paying for
links anywhere on the website
- The page the link is from has no adverts for porn or poker websites.

your link or back-link profile, is an overview of all of your links. This should look ‘natural’, it should include
links from a variety of sources, with different anchor texts and some links should be no-follow.
The perfect back-link profile would feature:

- Links from blogs, press release sites, websites and social media platforms
- it should contain links from websites of varying pagerank (see Web metrics secion)
- some links should be images
- anchor text should be varied. some links should contain your brand or site name, some should contain
keywords, some should be phrases, some links should be single words.

and remember:

“...Winners go home anD F*ck The prom queen”
(The rock, 1996)

in the world of seo this, unfortunately translates to -

“Winners geT To The Top oF googLe WiTh a greaT, 
naTuraL Looking back-Link proFiLe, obTaineD WiTh high 

quaLiTy conTenT ThaT peopLe WanT To Link To”
(Drew griffiths, 2012).

tHe

PerfeCt lINK
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seo campaigns are the new way to build links. They are along the same lines as a traditional marketing
campaign but via an online platform.

a typical campaign will be based upon a national or international event, such as a movie release, a national
day, christmas, a sporting event or anything people are likely to take interest in!

if your pr department will allow it - you have to take risks! When everyone on the internet is a publisher
and a producer, you have to cut through the sea of mediocrity and produce something that will make people
say “holy sh!t!” or at least make them want to share it with their friends!

Let’s say you want to do a campaign surrounding the FiFa World cup. First of all you would have to check
all copyright issues. make sure too that the event is relevant, or can be related to your site in some way. For
example, if you have a site about bodybuilding, you could create content about training programmes for
football players, or do an infographic on who has the biggest guns or wheels.

you could build a micro-site or a hub at your domain-name.com/World-cup

The hub could include infographics about players and teams, including statistics. infographics are basically
pictures that contain lots of information. google “infographics” to check out a few. you can use websites like
http://visual.ly/ to build your own.
you could put a video on the hub, for example a video recreating some of the training programmes done in
the gym by the players.
you could also have a competition for bloggers. e.g. a fantasy football competition with a decent prize.

if you have big budget and/or programming skills, you could also have an online game on there. anything
that people will want to use, and share with their friends. Whatever you do, you should look to put “social
share buttons” on all the pages, so that people can impulsively share your content with their friends.

seo campaigns
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seo page metrics should not be confused with analytics metrics such as bounce rate (percentage of people
who view one page of your site then exit) and conversion (percentage of people who complete a transaction
of some kind on your site).

seo metrics include google pagerank, and from the seomoz Toolbar (see plugins, below) page authority
and Domain authority.

page metrics

For seo purposes, you’ll want to use either Firefox or google chrome, not internet explorer.
you’ll definately want the moz bar which you can download from:
https://chrome.google.com/webstore/detail/mozbar/eakacpaijcpapndcfffdgphdiccmpknp

The moz bar is a must! you can use it to view page metrics immediately and also to highlight no-follow links.

seo serp on chrome is a really quick and easy way to check your rankings

For Firefox, the best plugins include -
searchstatus
rank checker
showip

web browser 

plugins
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competitor analysis is an important part of seo. even before you start an online business for example,
you should ideally check out what kind of backline profile the top sites on google have for your most 
 valuable keyword(s).

Will you be able to compete with the top guys on google?

you can also use competitor analysis tools to check up on the link building of your nemesis sites. This can
be an easy source of link building opportunities for your own site. chances are if a website gave a link to
your competitor, they will give a link to you. competitor analysis can therefore provide “quick wins” in
terms of building links.

also, if a site suddenly jumps up in the rankings, you can check out their back link profile to see how they
have done it.

simply type the competitor’s urL into the space provided on http://www.opensiteexplorer.org/ and/or
http://www.majesticseo.com/
unfortunately you will have to pay to get all the functionality from these two sites. ideally you’ll need
some half decent excel skills to really analyse the data too.
you’ll probably have to download csV files. To convert these into something more usable - highlight
column a, then go to the Data tab on the ribbon/Tool bar, and choose Text to columns. click next and
then check commas in the second box, then finish.

competitor 

analysis
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you would use an advanced search query in an attempt to find a very specific web page.

They are used via google. For example to find blogs about guns, that accept guest posts you would type the
following into google’s search bar:
inurl:guest-post + guns
This returns websites that have the word “guns” and “guest-post” in their web address, or urL somewhere
(hence the search term “inurL”.)
For example, the above search query returned the page

http://www.momwithagun.com/2012/08/guest-post-flashlight-self-defense-ben-branam/

you can just use the advanced search page:
http://www.google.com/advanced_search

For even more search operators, see the official google page here:
http://support.google.com/websearch/bin/answer.py?hl=en&answer=136861&topic=1221265&ctx=topic

advanced search

queries
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people write entire books on social media marketing. Let me save you the agro and summarise what you
need to know:

google, somehow, track social media interactions, shares, retweets and general activity and it has now 
become an important part of the algorithm. To succeed in social media marketing you need to:

- have a Facebook page, a Twitter account, a youtube account, a google+ account and page, a linkedin
 account and page and a pinterest account for your business. consider getting a Wordpress.com blog too.
-  you can use hootsuite to aggregate a lot of your updates. Don’t depend on this however, mix up your
 content and updates. What is suitable and funny on Twitter, may not translate well to Facebook and
 especially not Linkedin.
-  Don’t sell directly, not too often anyway. if all you do on Facebook is post your website urL, people will
 start to ignore you or unlike you.
-  Write updates linking back to content on your site.
-  create a well tidy page cover photo using either your graphic design skills or pagemondo.
-  For Facebook visit the official business guide at https://www.facebook.com/business/
-  set up your Facebook page and make sure it has a great cover photo! Don’t include your urL on it though.
-  all on social media platforms give exclusive insight into your business and if applicable, special offers.
-  post at least 2 times per week on all platforms.
-  Videos, photos and photo albums gain more interaction than plain text updates.
-  comment and create content related to national events, such as sports tournaments and national days  
 and celebrations.
-  When possible, keep updates in-line with your brand.
-  Develop a unique voice. your brand should have a consitent personality.
-  if you are a ‘business to business’ marketer then Linkedin is the place to be! add connections and seek out
 local businesses and groups.

-  apparently, if you share an update on Linkedin, and also tick the box to get it shared on your Twitter profile
 at the same time, every retweet your update gets, also counts as a Linkedin share. This, in theory, can
 double the impact in terms of “social signals/noise” that google monitors to determine rankings.

-  create great content on your website, and share it via a link on all your social platforms.

-  become an “authority” in your chosen field by writing a book and making it a free downloadable asset on
 your website. share the link on all your social media platforms.

-  build relationships with bloggers in your niche. “scratch their backs” whenever you can. relationship build
 with them by following and sharing, and interacting with their blog posts and social media updates.

-  use followerwonk.com to find the most influential Twitter users in your niche. you can also use it to add
 people who may be interested in your services/product in your area.

social media

marketing
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- competitions can work really well on social media websites, but you must read the official terms and
 conditions for each website first. have a look at section e for example, on the official Facebook page
 guidelines https://www.facebook.com/page_guidelines.php
-  Devote some time to Linkedin groups. Find groups relevant to your niche, and answer questions and link
 to other websites, sometimes your own to help answer questions. join local groups in your niche if
 possible.
-  consider making podcasts, with interesting content relating to current new or trends in your niche.
-  remember people are lazy! so make sharing content as easy as possible. Facebook, Linkedin and
 google+ all allow you to place social share buttons (yes i know i mentioned these before) into emails,
 pdfs, and of course websites and blogs. place these strategically within your content.
-  To place a Facebook share button in a pdf, insert a Fb logo pic, then add a link to:

https://www.facebook.com/sharer/sharer.php?u=yourwebsitename

so, if you wanted to share my hompage for example, insert a Facebook logo image wih a link the link:
https://www.facebook.com/sharer/sharer.php?u=http://www.seoandmma.com

copy and paste the urL into your browser to make sure that it works

For google+ the initial urL is https://plusone.google.com/_/+1/confirm?hl=en&url=
For Linkedin it is http://www.linkedin.com/sharearticle?mini=true&url=

- research what your customers are saying online about your company, what issues they may have for
example, and address this in your social media campaigns.

social media
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To set up a basic wordpress account, go to Wordpress.com and click “get started”.
The process is pretty straight forward from there, just fill in your details, make a note of your username
and password and try and name the site with a keyword in the title.

a’Theme” is Wordpress’s term for a website template. you can amend the text on them easily and the
images.

once your site is up and running, you can login to the admin area, or the “dashboard” by navigating to
yoursitename.wordpress.com/wp-admin

To add pages to your blog e.g. an about us page, that you might see on a normal website, and perhaps a
contact us page or a gallery page; use the menu on the left hand side, navigate to pages - add new
(see below). To add a new post (like a daily update of company news), simply click “posts” - add new

you can edit the site title and the site tag line by going to “settings” - “general”
you can edit the header under the appearance section of the menu on the left hand side

wordpress

basics
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To insert an image into a new page or post, click the icon near the top left hand side (see arrow on image
below pointing to the icon that looks like a camera and a musical note). you can then upload an image to
your “media libray”, give it a name, and an alt text, and insert it into your post or page.

inserting a link can also be confusing. just highlight the text or image that you want to make into a
link, and then click the icon on the toolbar that looks like a small chain (see pic below). Type your link
and click if you want the link to open in a new window or not.

Wordpress is pretty straight forward once you get the hang of it. just sign up for a free account and have
a play around with it. customizing the designs can get a bit more complicated. if you want to learn more
about the platform, then i’d recommend looking at some tutorials on youtube or doing some of the courses
available on udemy.com

wordpress
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if you haven’t got someone to teach you, i’d recommend studying excel via youtube and working along with
the tutorials. For seo you will need to know formulas, and how to sort data, especially from csV format.
you’ll also have to do a lot of reporting via charts and graphs and you’ll have to know what to do with data
downloaded from the likes of opensiteexplorer and majestic seo.

below are a few things to know as a starting point

The FiLL hanDLe.
hover over the bottom right of a cell and your cursor should change to a little cross. if you click and drag
down excel will copy down a formula or autofill cells below as it predicts what kind of data you are entering.
e.g. if you have one cell with “january” in it, and you drag the fill handle down, excel will fill the cells with
other months of the year (in the correct order).

basic FuncTions
When using a function, as use the = sign first in a cell. it’s kind of the reverse of what you were taught in
school but think of it as “this cell = this formula”. after all, the contents of the cell the formula is in, is going
to become the output of that formula

counTiF
syntax: =counTiF(range,criteria)
counTiF function is used to get the number of instances of a particular type or criteria of data in a given
table or column.
For example. if you had a table full of exam results, you could use counTiF to calculate the number of
times an “a” grade was awarded. Type “=counTiF” into a cell, then click with your mouse and highlight
the column of data containing the grades then enter a comma, then “a”.
your function should look something like this:
=counTiF(b2:b30,”a”)
b2:b30 represent the second column from the left of the spreadsheet, from the second cell from the top
down to the 30th. This is were all the grade data was stored in this particular example.

search
Tells you how many characters along a word or “string”, a particular letter of character appears.
FinD does the same thing but is case sensitive. Find is also useful if you’re dealing with urLs that contain
parameters.

excel basics
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iF, or/anD

These functions help to organise and present data.

say for example, you have a spreadsheet containing a number of urLs, you can use the iF function to find
out which section(s) of the website are getting the most traffic.
iF can be used to check whether a condition is met, and returns one value if True, a different one if FaLse
(condition not met).

The syntax looks like this - =iF(LogicalTest,output_if_True,output_if_false)
For example you might write - =iF(a1=5,”good”,”nogood”)
if a1 is equal to 5, then the output would be “good”. if not, the ‘value returned’ would be “nogood”

min - can be used to display the smallest number in a given column or table.
max - =max(b2:b8) will show the largest number in the column b2 down to b8

absolute referencing - to fix a cell reference place dollar symbols $ around a cell reference.
For example, b10 absolute reference (rather than relative) would need to be written as $b$10
Look out for these, they may be useful or may confuse you when dragging formulas using the fill handle

FormuLas across WorksheeTs -
use an exclamation mark ! to tell excel that you want to reference a cell on a different worksheet. For 
example =sheet1!b9 will reference cell b9 on sheet 1
you can write this into your cell manually or just copy the cell from sheet 1, then paste special - paste as link
and paste the same formula into your cell on a different spreadsheet.
you can start a formula in sheet 1, then click onto sheet 2, select a column to reference and then press 
enter (do not click back to sheet 1). This is an easy way to reference data from a different worksheet.

if you want to add up different cells, in different worksheets, you can click on each cell typing in a + between
clicks. you can use formulas without moving outside your first worksheet. For example:
=sum(sheet1:sheet5!b3) will add up all the b3 cells in sheets 1 to 5.

using Formulas Tab you can give a name to a range, or cwhole olumn or row. highlight cells you want to
group together and give a name to, and then click on Define name, near the middle of the Formulas tab. if
you select a whole column or row, it will auto-update when you add data to it.

=iF(sum(b20:g20)>=200,”awesome”,”Too Low!”)

if all the cells between b20 and g20 added together equal an amount greater than or equal to 200 then 
the cell with the formula in will read “awesome”, otherwise it will read “Too Low!”.

basic functions
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V stands for Vertical. you can also do a hLookup. This is quite a common function and one you’ll probably
have to know. it basically “looks up” or finds a value from one table and puts it into another.
it took me a while to get to grips with this function. Don’t worry if you don’t understand it straight away. i
watched about 5 tutorials on youtube before attempting it myself and needed about 20 practices before i 
understood how to use it fully. even the tutorial on the Dummies webpage confuses me!

The syntax looks like this:

=VLookup(lookup_value,table_array,col_index_num,range_lookup)
or
=VLookup(criteria, Lookup Table, column to return, True or False)

roughly translated into meathead english this means:

=VLookup(cell_who’s_value_you_want, cell_range_of_Table_with_value, column_Value_is_in, close or
exact match?)

so to break this down further into instructions -
To do a vlookup - click on cell you want to lookup the value for, highlight the table that contains the value you
are looking for, type the internal number from left to right of the column the value is in, then type false unless
you want a close match instead of an exact one.  example - below, we want to include the fighters style in 
column D.  so we take it from the table in columns
h and i, by telling excel the name of the fighter to look up (bob, in cell a2), where the look up table is, and
which column contains the info about the fighter’s style. We add false at the end to ensure an exact match 
for the name:
 

e

vlookup
The moTher oF aLL FuncTions!
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sometimes you won’t watch to use an exact match in VLookup, so you type “true “ at the end of the formula 
to get an ‘approximate’ match.
an approximate match works well with thresholds. For example, if you want to work out and returning
grades. For example, if you want to look up the grade for 57% and in the lookup table grade c is between
50% and 60% then VLookup approximate (true) match should return c, even though there is no value that
exactly matches 57% in the grades table.
even though 57% is closer to 60% and a grade c than 50%, an approximate match will not return the 
closes match, it returns the threshold it has exceeded. in this example, 50% was exceeded (the threshold 
for a grade c) but not 60% (the threshold for a grade b), therefore the value returned would be c.
The values in the lookup table, have to be in ascending value i.e. smallest at the top, largest at the bottom.
This is a bit annoying and something to watch out for when using approximate match.

piVoT TabLes

pivot Tables are awesome for sorting and displaying data! They put data into groups and all sorts, so that 
you can view, understand and interpret your data alot easier.
To create one of these bad boys for your own data, simply click somewhere inside your data - you don’t have
to highlight it. 
click the insert tab on the menu bar / ribbon. if your computer has the default settings on the pc, then on 
the left hand side there should be an icon with “pivotTable” underneath it. click the icon my friend... click ok 
on the pop up menu to insert the table on a new sheet.

now, you should find yourself on a new worksheet with a table of some sort near the left and some boxes on
the right hand side of the screen. To construct your table, you will need to drag Field names form the top
right box, into one of the smaller ones underneath.

The row labels will appear down the left hand side of your table, the column labels will appear along the top,
and the values are the actual data that fills out the table. if you put a report filter in, then it allows you to
choose to view different types of data. For example, if your report filter was Weight Division, and the Values
box contained the earnings; you could choose to view all, some, or just one particular weight division at a
time and see how much the fighters earn.

When you specify a field as a label, it displays a new column / row for each unique value that it has.
For example, if you chose “months” as a column label. Then each month of the year would have a unique a
column. if you were creating a table about exam results however, and you choose “percentage” as a column
label, then this may get quite messy and result in a very wide table with lots of different columns for every
different percentage exam score. percentage would have been better placed within the Values section on 
the pivot table creater.

Watch out for the field in the Values section. sum is the values added together, count if the number of
occurrences. you can click on the field(s) within the Values section and change this to sum, count, max,
min or even average if you like. you can change the number format too, to change the values to pounds 
sterling for example, just click the number Format box.

vlookup continued...
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To insert one of these, click inside your data, go to the insert tab, click on the drop down menu under the
pivotTable icon and select pivot chart. This will create a pivotTable and a pivot chart!

if you already have a pivot Table, just click in the table somewhere and press F11.

in the Design tab, you can change the chart design. click change chart Type which should be on the left
hand side if you have the default setup on the pc. on the Layout tab you can change labels and titles and
other stuff, and also add a trend line.
you edit and construct the pivot charts the same way you edit the pivot Tables - by dragging fields from the
box on the top right into the boxes below.
ideally you will have visualised your chart before you try and construct it in excel. For your first few
attempts you may even find it helpful to draw out a chart using your data before you try and build it in excel.

For printing you can get rid of the field boxes by clicking the analyse tab (appears when chart or part of 
chart is selected), and then click on Field List and/or Field buttons.

you can move the chart to another sheet by clicking the Design tab and then move chart which should be 
on the right hand side of the tool bar / ribbon.

imporTanT concepT
you may need to “group” raw data before creating a pivot chart. For example, if you have a long list of dates
as the column headers, click on one of these dates then navigate with your mouse to the options Tab and
then click group selection. using the pop-up box, group by month or quarters, or whatever you like and
press the “ok” button. you can then click any cell in your table and in the right of the options Tab/ribbon
click the pivotchart icon - a line chart would generally be best to display trends and changes over time.

on the left of the Design Tab of the Toolbar / ribbon you can click the switch row/column icon to reverse
the labelling and layout of your chart.

if the pivot chart looks somewhat crowded then you can click on the Field’s drop down menu (indicated by
arrow inside the grey box beneath the title of field) and choose the Value Filters and select a filter, such as 
Top 10, to show just to top 10 values. screenshot shows the Filter and sort drop down menu:

pivot charts
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being able to sort data is essential in seo, especially if you work for a big company that has to report to 
share holders and construct business analysis and business proposals.

The Filters are an easy way to organise stuff. under the Data Tab on the excel ribbon / toolbar you will find
the filter icon. it looks like a big funnel. click this and then choose what data to display and hide using the
drop down menus and check boxes that appear at the top of each column. make sure your columns have
headers before clicking the icon.

To sort a column in alphabetical order, click in column that you want to sort, go to Data tab and click on sort
aZ icon with the downward arrow next to it. easy!

click the big sort icon that looks like a box with a blue lid,           and it brings up a dialogue box. you can
sort by a primary factor, then a secondary factor. you might use this to sort a list of T-shirts into categories
and then within those categories, put the most expensive at the top and the cheapest at the bottom.

if you then wanted to put the T-shirt in order of size, small, medium, Large, xL, xxL, then you would need
to click in the size column, click the sort icon (box with blue lid icon with aZ on it and Za), then choose
custom sort. you can then add a custom List. Type in small, medium, Large, xL, xxL and click add.

random tip - To remove duplicate data, go to the Data Tab and click remove Duplicates near the right hand
side.

sorting data
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These annoying little buggers are slightly less annoying when you know what they actually mean:

#DiV/0!
Trying to divide by 0 - for example if an empty cell is in a formula

#num!
again happens if there is a 0 or empty cell. e.g. 0 to the power of 0

#name?
usually a misspelt formula

#n/a
no Value is available. This is often seen when you do a VLookup with an exact match (,false at the end of the
formula), but there is no exact match to be found.

=if(b2=0,”unable to calc”,b1/b2)
if b2 is equal to 0 then “unable to calc” will display in the cell
if b2 is not equal to 0 then the result of b1 divided by b2 will display.

=if (b2=0,0,b2^b3)
if b2 is 0 then display 0, otherwise calculate b2 to the power of b3.

iFerror FuncTion
if you don’t like your spreadsheets full of error messages, you can use the iFerror function to display 
something else when you do get an error.

For example:
=iFerror(a2/b2,”oh hell”)

in the above formula, if the dividing a2 by b2 produces an error, then “oh hell” will be displayed in the cell,
instead of an error message.

errors
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just when you think you’ve learnt everything you need to for web design, the powers that be go and release
this beast. Very annoying i know, but you can defeat it! Like predator beating alien!

http://www.w3schools.com is a great place to start learning about hTmL 5.

hTmL structures a webpage into different sections. instead of using a generic <div> sections for everything,
there are now different markup elements to use, such as <footer>, <nav> and <header>

another thing to be aware of, is the new host of apis that have become available. api stands for application
programming interface. They can normally be used with javascript. The Twitter api for example, makes it
easy to put Twitter feeds on your website.

html 5
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hTmL 5 offers more descriptive, and more specific markup. For example, if you write an article, then you
would identify it as such with the <article> tags. hTmL 5 also has a number of tags for different forms of
media. For example, surround video or movie with the <video> tags, whilst the <canvas> element is used to
draw graphics. This specific type of markup will also help with seo. boom!

have a look at the bare-bones of code for a hTmL5 page:

<!doctype html>
 <head>
   <meta charset=”utf-8”>
   <title>bones of a hTmL 5 page</title>
   <meta name=”description” content=”Welcome to my basic page about arnie.”>
   <link rel=”stylesheet” href=”css/style.css?v=1”>
</head>

<body>
    <div id=”wrapper”>
       <header>
          <h1>arnie is a Legend!</h1>

          <nav>
              <ul>
                 <li><a rel=”external” href=”#”>home</a></li>
                 <li><a rel=”external” href=”#”>about</a></li>
                 <li><a rel=”external” href=”#”>contact</a></li>
              </ul>
          </nav>
       </header>

    <div id=”core” class=”clearfix”>
       <section id=”left”>
          <p>arnie is a massive hero....</p>
       </section>

       <section id=”right”>
          <p>sly on the other hand..</p>
       </section>
    </div>

    <footer>
       <p>This is the footer</p>
       </footer>
    </div>
</body>
</html>

beautiful isn’t it? have a look on the next page to see what the resulting Webpage would look like. note the
<footer> and <nav> tags that are used. This could be easily edited by changing the text within the <h1> tags
and the <p> tags. you woud probably want to add some images and a bit of css3 too though, just to jazz it
up a little bit!

html 5...
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The canvas element in hTmL 5 however, can only be ‘drawn’ on with javascript. This is pretty complicated
for a meathead. your best bet is to visit the W3 schools tutorial. you can draw a picture using javascript or 
insert an image, again, look at the tutorial from W3 schools.

you should also be aware of the cool feature that is hTmL 5 Drag and Drop. This is pretty cool, but again the
code can get pretty complicated for your average action hero. Don’t worry though, just cheat like i do. Find
an example piece of code, like the one on the W3 schools tutorial and edit it to change the picture to one of
your own. This is much easier to do with Dreamweaver. you basically have to upload the relevant picture
from your computer to the webpage. you can just browse and double click the picture in Dreamweaver,
whereas with something like notepad you will need to put the full filepath.

Forms have been improved upon in hTmL 5. Form elements have a great degree of ‘semantic markup’ and
remove a great deal of the scripting that was required. check out tutorialspoint.com/html5/html5_web_
forms2.htm for more info and some example text.

hTmL 5 can also do other mad stuff by incorporating apis that generally work together with javascript. For
example the geolocation api. This returns a location and accuracy based on information about WiFi that
the mobile client can detect.

have a look at a few articles and/or videos on media tags too. The final nail in the online coffin of Flash?
quite possibly, the <video> tags, for example, certainly won’t help its cause. in it’s simplest form the Video
tag would look like this: <video src=”videoclip.mp4” controls />

and finally, here is what my hTmL 5 arnie page would look like with the code from the previous page of
this book -

html 5...
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This book was written by Drew griffiths (me).

i am a (bad) amateur mma fighter and kickboxer from Wrexham in the uk and have a First class
honours Degree in sport science from Loughborough university and a msc in exercise & nutrition
science from the university of Liverpool.

i had a change in career in 
2011 and qualified with the 
chartered institute of market-
ing with a Diploma
in Digital marketing, from the 
oxford college of marketing. 
i now (2012) work as an seo 
specialist at a
price comparison website. 
This book kinda combines my 
love of training/getting mas-
sive and generally
doing macho brainless stuff, 
with seo.

i had the idea of writing all 
the fundamentals from each 
aspect of seo in one place for 
easy reference. 
i was learning how to use 
inDesign at the time, so 
thought i would turn the 
whole thing into a book. 
i thought seo for all action 
heroes would be more fun to 
create than a run of the mill 
seo for chuffin
beginners book or Dummies 
etc...
hope you liked it; i don’t 
make any money from this 
book; just putting that out 
there.
really hope people find this a 
useful reference, or even adds 
to your current skillset.
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